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Chapter 1

Understanding Windows Server 2008
Server Core

For anyone who’s worked with computers for a long time, Windows Server 2008 Server Core seems
like a step into the past. After all, this new operating system is Windows without the Windows
features—it’s essentially a decorated command prompt. In fact, you can change the appearance of
Windows Server 2008 Server Core to look just like the command prompt applications you may
have used in the past. Of course, it’s not quite that simple or you could just buy one of the ancient
tomes on DOS to find your way around. All of the features you expect from Windows Server still
appear in Windows Server 2008 Server Core—the only difference is that you must use the command
prompt to manage them, which means using a different administration method than you probably
use today.

Eliminating the graphical user interface (GUI) has certain security benefits. It's a lot harder to
infect a machine that lacks a browser such as Internet Explorer. In fact, it's not too hard to imagine
that infecting such a system from the inside would be very difficult indeed. In addition, using a
command line interface can be faster than using the GUI once you have some basic management
tools in place. Of course, not having the GUI tools also presents a number of problems. Many
administrators have never worked at the command line so they don’t have the skills required to
manage a server that has only a command prompt for input.

This chapter presents a starting point for working with Windows Server 2008 Core Services. For
many people, it's going to be very shocking to start Windows Server and see nothing but a command
prompt (even the Start menu is missing). The overriding goal of this chapter is to make you feel more
comfortable in such an environment and help you discover that nothing’s really missing—it’s just
different from what you've used in the past to manage Windows.

In this chapter, you'll learn how to do the following:

@ Define the Server Core difference in command prompt management

Describe how to access operating system configuration without the Control Panel
Configure your server for initial use

Perform tasks at the Logon screen

Manage applications and the environment using the Task Manager

Use a few GUI utilities to help manage the operating system

® 6 6 O o o

Run DLLs using RunDLL32 to perform tasks at the command prompt

%




%% é 38400c01.fm Page 4 Monday, December 17,2007 7:03 PM

4 | CHAPTER 1 UNDERSTANDING WINDOWS SERVER 2008 SERVER CORE

Considering the Command Prompt

For many people, moving to the command prompt after relying on a GUI for so long is going to be
a big change. When working with Windows Server 2008 Server Core, you perform all tasks at the
command prompt, which may seem impossible, but is really quite doable. Administrators with
more experience may remember using the command prompt exclusively in the past and for them
returning to Windows Server 2008 Server Core is simply a return to what they’ve done before.

In fact, many experienced administrators will welcome the change because working at the com-
mand prompt can be considerably faster than trying to locate features in a GUI. Working at the
command prompt trades flexibility and speed for ease of use and fewer errors.

Of course, the main question for most administrators is why create what essentially amounts
to a command prompt version of Windows—a Windows without windows. The following list
describes the reasons that Microsoft apparently decided to create the Windows Server 2008 Server
Core version.

NOTE Because this book doesn’t discuss any other version of Windows, I’ll use the shorter Server
Core to refer to Windows Server 2008 Server Core from this point. Whenever the book discusses
some other version of Windows, it will include the full name. In addition, when the book dis-
cusses Windows in general, you’ll see Windows by itself.

Fewer Maintenance Requirements A graphical interface costs you when it comes to mainte-
nance because you have to maintain the graphical applications in addition to all of the essential
operating system files. Server Core contains only the software required to create a server that
has the Active Directory (domain controller), Active Directory Lightweight Directory Services
(AD LDS) (formerly known as Active Directory Application Mode), Domain Name System
(DNS), Dynamic Host Configuration Protocol (DHCP), File, Media Services, or Print roles. You
obtain a fully functional server, but because the server doesn’t include a lot of baggage, it
requires a lot less time to maintain. Notice that this list doesn’t include a database server. Some
server roles still require a GUI and you have to consider that issue when installing Server Core.

Reduced Security Risks Security is a major problem for most companies today. Microsoft is
promoting the idea of a reduced attack surface in many of their products. You only install what
you actually need to perform a task. By reducing the amount of software on a system, you also
reduce the number of items that someone can attack. A successful attack requires a security hole
and, with fewer pieces of software, there are fewer holes to exploit. Because it lacks a GUI, Server
Core has the potential to significantly reduce the security risks for your server—in fact, given

that today most security holes rely on a graphical utility such as a browser, you may find that
Server Core has almost no security threats to consider.

WARNING A reduced security risk doesn’t translate into no security risk. Poor passwords, an
unfriendly employee, a determined outsider, and even faulty hardware still offer ports of entry to
attack. Server Core reduces risk but can’t eliminate it, and never fool yourself into thinking that
any product can eliminate security threats. You must always remain vigilant in looking for
unwanted entries.

Fewer Management Requirements You may be surprised to learn that the GUI applications
on a server require far more management than a command line application ever will. By remov-
ing the GUI, you also remove many of the management requirements for a server. Using Server
Core makes administration considerably less time consuming, which translates into reduced
costs. Of course, the administrator is going to need a good knowledge of the command line.
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Consequently, even though you have fewer management requirements, performing the actual
management tasks is going to be more difficult because you won’t have a GUI to provide those
little reminders of what to do next.

Improved Resource Usage If you're tired of upgrading your server every five minutes to meet
some new requirement, you’'ll really like Server Core. The GUI elements of the operating system
chew memory like candy and drink hard drive space like soda. When you eliminate the graphic
applications that insist on running in the background and all of the other eye candy of the oper-
ating system, you find that system resources go considerably further. Of course, you don’t get
the benefits of the GUI either. For example, it's much easier to track performance using a GUI

than it is to view the same information using a scrolling display of numbers. In some respects,
the reduced resource requirements come with a price of potentially harder management in some
situations (such as tuning server performance).

You may wonder about Internet Information Server (IIS) support in Server Core. As of this writ-
ing, it's possible to run a subset of standard IIS applications on Server Core. However, the Server
Core version of IIS will have severe restrictions due to lack of .NET Framework functionality. In
fact, IIS won’t have the following features.

ASP.NET
¢ The IIS Management Console version 7 (since it requires a graphical interface)
¢ The IIS Management Service
¢ The IIS Legacy Snap-In or IIS Management Console version 6, for managing legacy Web

sites
¢ IIS FTP Management
& The Windows Activation Service

In short, you'll be able to use IIS to run static and some scripted applications, but that’s about it.
For example, you can use IIS to run Active Server Pages (ASP), but not ASP.NET applications. Any-
thing with JavaScript should also run fine and you can use technologies such as Asynchronous
JavaScript and XML (AJAX). The Common Gateway Interface (CGI) application support will still
work fine, which means you could also run implementations of Practical Extraction and Report
Language (PERL) and so on. Consequently, the loss of functionality isn’t as bad as you may initially
think, but IIS under Server Core isn’t going to be the platform of preference for many people.
Whether you can use IIS depends on the kinds of application support you require.

The biggest problem with IIS support in Server Core, however, is management. IIS is an example
of an application that really does work better with a GUI than it does at the command line.
Although you can manage IIS at the command line, this functionality is probably limited to smaller
Web sites where you don’t have to coordinate the efforts of multiple servers. Chapter 25 details
how to manage IIS with Server Core.

Life without the Control Panel

It's important to remember that the Control Panel applets are a graphical feature of Windows. Most
of these applets rely on the Microsoft Management Console (MMC), a host application. You'll find
thatnothing in the Control Panel appears with Server Core. At first, this omission may make it seem
impossible to manage Windows. However, just about everything you need to mange Windows

does appear as part of the command prompt, as you'll discover as the book progresses. For example,
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if you want to add or remove users, you can use the NET USER utility to do it, or create a VBScript
script to perform the task. You'll find a discussion of these techniques in the “Creating, Deleting,
and Managing Users” section of Chapter 20.

However, the command line isn’t quite complete. For example, you can’t change some charac-
teristics of the GUI display using the command line feature. Of course, given that the GUIisn’t abig
part of the Server Core feature, this may not even be a consideration for you. To change the GUI dis-
play, should you need to do so, you'll have to rely on registry hacks. You'll find a number of these
hardware modifications provided in the “Modifying the Hardware Setup” section of Chapter 4.
The point is that the omissions generally affect something that you won’t use a lot in Server Core
and you probably won’t notice they’re missing.

One omission you'll definitely notice is that it's harder to install applications in Server Core. You
won't find the familiar Add or Remove Programs appletin Server Core, but you still have a number
of methods of working with applications at your disposal using the command line in this case. The
“Performing Application Installations” section of Chapter 3 provides everything you need to
install applications in Server Core. In fact, the entire chapter is useful reading when you know a
GUI method exists for performing a common configuration task, but you don’t see it anywhere in
Server Core.

The Control Panel admittedly contains a number of applets you'll never need in Server Core,
s0 it’s impossible to miss them. For example, you won't have to worry about managing your
game controller because Server Core isn’t suited to the task. In addition, you can’t really use
Server Core for database management, so the lack of a Data Sources (ODBC) applet in the Admin-
istrative Tools folder of the Control Panel isn’t much of a concern. (ODBC stands for Open
Database Connectivity.) Because Server Core lacks any form of Internet Explorer, you also won't
need to worry about the Automatic Updates applet. All of these omitted applets don’t have a
use in Server Core, so Microsoft doesn’t provide any means to perform the related tasks at the
command line either.

Configuring the Server for Initial Use

Installing Server Core is only part of the installation process. When you start Server Core the first
time, you'll need to perform some configuration that you might not have had to performin the past.
The first step is getting logged in. You'll see the Press Ctrl+Alt+Del to Log On message as usual.
However, after you press Ctrl+Alt+Del, all you’ll see is an entry for Other User—leaving you to
wonder where the Administrator account is. Click Other User and type Administrator in the User
Name field (do not include a password). Click the Right Arrow icon. It's only at this point that
Server Core finally decides to tell you that you must change the administrator password before you
use the account the first time. Click OK and follow the prompts to change the password. At this
point, you finally see the messages that the setup program normally displays when configuring a
new operating system. At some point, you'll see a command prompt as shown in Figure 1.1 and
that's it.

No, your system isn’t broken. You won't see a Start menu or any of the other usual GUI features
of Windows. Unlike other versions of Windows, you perform all configuration tasks at the com-
mand prompt. (If you want to get a quick look at some of the available commands, try the Help
command described in the “Obtaining Command Line Help with the Help Utility” section of
Chapter 5.) The following steps will help you get started setting up the server.

4~ 40



%% é 38400c01.fm Page 7 Monday, December 17,2007 7:03 PM é

CONFIGURING THE SERVER FOR INITIAL USE | 7

FIGURE 1.1

Server Core only
displays a command
prompt, soyou need inis! dows' system 32 omd.exe
to know how to use C:\Wsers\Adninistratory.

text commands.

Windows Servel 2008 Enterprise
Euild 6001

1. TypeNet User YourLoginName YourPassword /Addand press Enter. (The Net utility is one
of the more useful utilities at your disposal and you'll find it fully documented in the “Man-
aging the Network with the Net Utility” section of Chapter 10.) This step sets up an account
for you. Of course, you won't have administrator level privileges. I'm assuming that you're
not using this setup on a domain, so you'll need to add your account to the Administrator
group using a LocalGroup. If you're working on a domain, then you'll need to add your
account to the Administrator group using a Group instead.

2. TypeNet LocalGroup "Administrators" YourLoginName /Add and press Enter. Younow
are part of the Administrator group and can log in under your own name to the system.
More importantly, you've just gained the ability to access the server remotely using Remote
Desktop without having to perform a significant amount of configuration. You'll want to
know what to call the computer, so you need to change the name of it next.

3. Type WMIC ComputerSystem Where Name="%COMPUTERNAME%" Call Rename
Name="NewName" and press Enter. Make sure you choose a name that will work with your
workgroup or domain setup. Of course, the computer isn’t part of the workgroup or domain
yet, so that’s what you need to do next.

NOTE The WMIC command is one of the most powerful configuration features of Server Core.
You’ll find the main documentation for this command in the “Configuring Server Core Using the
WMIC Command” section of Chapter 3. However, be sure to check the “Working with the WMIC
Job Alias” section of Chapter 8, the “Managing Directory Services Using the WMIC NTDomain
Alias” section of Chapter 19, and the “Making Modifications Using the WMIC Utility” section of
Chapter 20 as well for additional WMIC information.
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4.

NOTE

Type WMIC ComputerSystem Where Name="%COMPUTERNAME%" Call
JoinDomainOrWorkgroup Name="NameOfWorkgroup" and press Enter. At this point, you
have an account on the system and you're part of the Administrator group. Your computer
has an easy-to-type name that you know and it’s part of your workgroup. At this point, you
need to set it up for remote access.

Type WMIC RDToggle Where ServerName="%COMPUTERNAME%" Call
SetAllowTSConnections AllowTSConnections="1" and press Enter. After you reboot the
system, it provides Remote Desktop capability. However, the firewall prevents you from
making a connection, so you need to open a port for the Remote Desktop.

Type NetSH Firewall Set PortOpening TCP 3389 "Remote Desktop" and press Enter.
(You'll use the NetSH utility for more than just the firewall configuration; see the “Scripting
Networking Solutions with the NetSH Utility” section of Chapter 6 for more details.) The
firewall now permits you access to the server. It's important for some tasks to have access to
the C drive as well, so you need to create a share. The default share automatically provides
the required permissions.

. Type Net Share "Drive_C"=C:\ /Grant:Everyone,Full and press Enter. Everyone

now has access to the C drive. You can refine the permissions later. However, now you have
the required account, permissions, computer name, workgroup, remote access, and drive
access. Many of the commands you’ll work with in this book are actually scripts. The default
scripting engine is WScript—Microsoft uses the graphical engine for compatibility purposes,
but the graphical engine doesn’t work very well in a command line environment. The next
step changes the default scripting engine to the command line equivalent.

In most cases, even if the Server Core partition isn’t the first partition on the drive, it will

appear as the C drive when you boot it. Server Core reconfigures the drive designations as needed
to make Server Core the C drive in most cases. As with anything Microsoft, you’ll find exceptions
to this rule, but be sure you know which drive Server Core actually uses when you boot it before

you start issuing any commands.

8.

10.

Type CScript //H:CScript and press Enter. (The CScript utility always uses a double slash
for its own command line arguments; learn more about this utility in the “Running Scripts
with the CScript and WScript Utilities” section of Chapter 6.) You’ll see a message telling
you that the default scripting engine is now CScript. You should activate your copy of Server
Core using the next step. However, you can skip this step and go right to step 10 if you
prefer.

Type SLMGR —ATO and press Enter. The activation process seems to take forever. However,
get a cup of coffee, and when you get back, you should see a confirmation message like the
one shown in Figure 1.2. (When using WScript instead of CScript, you’ll see a confirmation
dialog box that you'll need to dismiss by clicking OK.) It's time to reboot the system to
ensure all of the changes occur.

Type Shutdown /r and press Enter. (The Shutdown command provides a number of useful
command line switches that you can discover in the “Shutting the System Down with the
ShutDown Command” section of Chapter 3.) You'll see a message telling you that the sys-
tem will shut down in a few seconds. The system will reboot and you'll find all of the changes
you've made in place. You should also be able to access the system using Remote Desktop
at this point.

%
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FIGURE 1.2
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C:ulzerssAdministrator?_
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NOTE Sometimes the WIC RDToggle command won’t work properly with older clients. In
this case, type SCRegEdit /CS 0 and press Enter. You’ll see a message that the script has
changed the proper registry entry. You must reboot the system after making this change using the
Shutdown /r command.

It's important to note that Server Core won't let you log into the host machine and into Remote
Desktop at the same time. If you plan to use Remote Desktop, don't log into Server at the host
machine. You may also notice some operational differences when working at the Remote Desktop
and you'll see a slight pause when Remote Desktop obtains updates from the server. All of these
issues are normal and you don’t need to worry about them.

NOTE This book assumes that you’re using Remote Desktop to perform all tasks, so your screen-
shots may appear slightly different from the ones shown in the book. In addition, this book
assumes that you’ll use CScript to execute scripts. The script output may appear different from
the output shown in the book when you use WScript.

CHANGING SHARE PERMISSIONS AT THE COMMAND LINE

You may wonder how to change share permissions at the command line. Apparently, Microsoft over-
looked this need as part of the default configuration. You need to download a tool called RmtShare from
http://www.petri.co.il/download_free_reskit_tools.htm to accomplish the task. This
utility makes it possible to manage share information on a local or remote drive.

Whenever you use RmtShare, you must provide the name of the server at a minimum and a share name
as well, in many instances, using the standard Universal Naming Convention (UNC) format. For example, if
you want to determine the shares on a particular system, you’d type RmtShare \\ServerName and press
Enter. The output shows all of the share names, associated resources, and comments for the specified server.

Of course, you won’t simply want to view the shares on a system; you’ll want to modify them in many
cases. You can use RmtShare to perform any required task. The following list describes each of the
RmtShare command line switches.

/USERS :number Specifies the number of users that can use the share at once. In some cases, you
need to limit the number of users to reduce the load on the server. TypingRmtShare
\\MainXP\Drive_D /USERS:5 and pressing Enter would limit the number of users using the
Drive_D share on MainXP to 5. You can’t use this command line switch with the /UNLIMITED com-
mand line switch.

- @
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JUNLIMITED Allowsanunlimited number ofuserstoaccessashareatonce. To use this command
line switch to change the Drive_D share on MainXP to unlimited, you’d typeRmtShare \\MainXP\
Drive_D /UNLIMITED and press Enter. You can’t use this command line switch with the /USERS
command line switch.

/REMARK: "text" Addsacomment to the specified share. For example, if you wanted to add a
comment of “This is Drive D” to the Drive_D share on MainXP, you’d type RmtShare \\MainXP\
Drive_D /REMARK:"This is Drive D" and press Enter.

/GRANT [user[:{READ | CHANGE | FULL}]] Allows a user or group to perform specific
tasks using the share. For example, if you wanted to allow a user named George full control of the
Drive D share on MainXP, you’d type RmtShare \\MainXP\Drive_D /GRANT George:FULL
and press Enter.

/REMOVE user Denies a user or group the right to use a particular share. For example, if you
wanted to remove the rights of a user named George from the Drive_D share on MainXP, you’d type
RmtShare \\MainXP\Drive_D /REMOVE George and press Enter.

/DELETE Removes an existing share. For example, if you wanted to stop using the Drive_D share
on MainXP, you’d type RmtShare \\MainXP\Drive_D /DELETE and press Enter.

Working with the Logon Screen

The Logon screen is one of the few GUI elements that Microsoft provides with Server Core. You
may very well have ignored it in previous versions of Windows because most of the tasks you can
perform at the Logon screen are also available using other methods. These methods aren’t available
any longer in Server Core. For example, you can’t right-click the Taskbar and choose Task Manager
from the context menu to display the Task Manager because there isn’t any Taskbar. Consequently,
the Logon Screen takes on a higher priority in Server Core.

The initial Logon screen displays just the name and password fields you've always seen. After
you log onto the system, you can press Ctrl+Alt+Del to display the Logon screen where the real
work takes place. The following sections describe each of the options in the Logon screen. If you
find that the Ctrl+Alt+Del key combination actually brings up the local Logon screen, rather than
the remote Logon screen, you need to change the Remote Desktop Connection application settings
using the information found in the “Working with the Remote Desktop Connection Application”
section of Chapter 2.

Locking the Computer

Clicking Lock the Computer displays the Press CTRL + ALT + DELETE to Unlock this Computer
screen. It lets you remain logged into the system while you leave to perform other work. To unlock
the system, press Ctrl+Alt+Del, type your password as normal, and press Enter. The system will
display the desktop as it was when you locked the system. Consequently, this feature isn’t quite the
same as logging off, where the system resets everything as if you hadn’t logged in before. In addi-
tion, any tasks you have running continue to run while you have the computer locked. Only the
user input features are locked.

Switching Users

Selecting this option lets you switch to another user. This feature doesn’t work as you expect from
the graphical version of Windows. You can’t switch between users—Server Core logs off the existing

- @
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user and switches to a new user. The only difference is that you save a few clicks using this approach.
Switching users when using a Remote Desktop session is the same as logging off—the Remote
Desktop session ends the moment the system logs off the current user.

Logging Off

You use this feature to log off of the current session. It's important to note that logging off will end
any Remote Desktop session as well. If you want to log off and log back into the server as another
user, then you need to start another Remote Desktop session to perform the login. You can also use
the Logoff command to perform this task (see the “Terminating a Session Using the Logoff Utility”
section of Chapter 5 for details on using the Logoff command).

Changing a Password

Microsoft recommends that you change your password using this option, rather than using the
Users folder in the Computer Management console. Since the Computer Management console isn't
available in Server Core, this option is your only way to change your password using a graphical
interface at the server. You can also change the password using the Computer Management console
from a remote machine, but using this approach can cause problems when you have encrypted files
or other resources since the Computer Management console technique doesn’t change the encryp-
tion (in other words, the files become unavailable). In fact, you'll see several warnings if you try to
use the Computer Management console technique.

Of course, your server may be located in a closet somewhere and you may not even have a key-
board or monitor attached to it. Another way to change the password is to type Net User UserName
* and press Enter. You'll see prompts for entering a password and confirming it. The characters you
type for the password won’t appear on screen. In fact, you won't see anything on the screen at all.

Invoking the Task Manager

Start Task Manager is probably the most often used option in the list because it helps you track run-
ning applications, end those that aren’t working properly, and start new applications as needed.
It's also possible to check on users with this utility and log them off when necessary. You'll see this
feature described in detail in the next section. You can also start the Task Manager by typing TaskMgr
and pressing Enter.

Using the Windows Task Manager to Your Advantage

The Task Manager takes on new importance in Server Core because it provides a convenient
method of performing basic tasks quickly. For example, you can use it to manage applications, start
or stop services, track basic system health, and manage user sessions. You can always start Task
Manager by selecting the Start Task Manager option on the Logon screen. It’s also possible to start
Task Manager by typing TaskMgr and pressing Enter. The following sections describe the Task
Manager features.

Working with Applications

Obviously, you won’'t have many applications running when you work with Server Core. In fact,
it's quite possible that you'll only see the one application shown in Figure 1.3 running when you
use this version of Windows. The command prompt is typically the only application you need to
work with in Server Core with any frequency.

- @
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You can use the options in the Applications tab to create, end, and switch tasks. In fact, you use
the Applications tab to re-create a command prompt should you end the CMD. EXE application (the
command prompt) accidentally. Simply use the techniques described in the Creating a New Task
session to start a new copy of CMD. EXE as needed to work through system problems.

CREATING A NEW TASK

The Task Manager lets you create new tasks as needed, including CMD. EXE, the most important
application for Server Core (see the “Starting the Command Interpreter” section of Chapter 5 for
details on working with CMD. EXE). Use these steps when you want to start a new application.

1. Click New Task. You'll see the Create New Task dialog box.

2. Type the name of the application you want to start in the Open field. Make sure you include
path information for the application as needed. The Browse button is inoperative in Server
Core, so you must know the name and location of the application you want to start. Fortu-
nately, any application that already exists in the Windows path, such as CMD. EXE, requires
that you only type the application name.

3. Click OK. Task Manager starts the application for you.

ENDING A TASK

Sometimes you may have to end a task manually. For example, an application may experience an
error and not end as normal. When this problem occurs, highlight the task in the list you want to
end and click End Task. Task Manager won’t display any confirmation message, so make sure you
end the correct task.

WARNING Ending a task using Task Manager can cause data loss or other problems. Always use
the standard application features to end the application whenever possible.

SWITCHING TO A TASK

Task Manager lists all of the applications currently running on your system. To select a new task,
double-click its entry in the list. Task Manager selects the task and automatically minimizes itself
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on the desktop (since there isn’t a Taskbar in Server Core to use for minimized applications).
You can also press Alt+Tab to perform the same task. If you find that the Alt+Tab key combination
actually switches between local applications, you need to change the Remote Desktop Connection
application settings using the information found in the “Working with the Remote Desktop Con-
nection Application” section of Chapter 2.

Working with Processes

Every application running on your system, whether it appears as a foreground task or a background
task, is a process. Foreground tasks are those that you start and interact with, such as the command
prompt. Background tasks are often started for you by the system and provide valuable services
such as letting you log into the system. You’ll find that Server Core uses far fewer processes
than a similar setup in the GUI version of Windows Server 2008. Figure 1.4 shows a typical list of
processes.

FIGURE 1.4
&3 windows Task Manager
See the processes run- Flle Optins View Help
ning forall sessions on “applications Processes | Services | Perfcrmance | Networking | Users |
the Processes tab. -
cl . ] 56 ind \ar ot
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|sarss. exe SYSTEM 1a] 3,550 K Local Security Authority Process
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ik sue METWORK SERVICE 13} 1,258 K M5 DTCoonsoke pragram
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The default setting shows processes from all users. If you only want to see your own processes,
clear the Show Processes from All Users option near the bottom of the Task Manager dialog box.
However, given the way in which you're using this feature, you’'ll probably want to see all processes.
To access a particular user process quickly, right-click its entry in the Applications tab and choose
Go To Process from the context menu. Task Manager highlights the entry in the Processes tab.

As with applications, you can choose to end a malfunctioning process. This act is dangerous
unless you know precisely how the ending the process will affect the system. Task Manager actu-
ally supports two levels of interaction in this case. You can choose to end an individual process by
highlighting its entry and clicking End Process. In some cases, a process will spawn (create) other
processes. In this case, if you end only the host process, the child processes may continue to run. To
end the host process and all its child processes, you should right-click the host process and choose
End Process Tree from the context menu.
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Processes also have two properties that you need to consider. The first is priority, which affects the
order Windows runs the processes. Windows executes all higher priority processes first. When it runs
out of high priority processes to execute, then it begins executing those of a normal priority and,
finally, those of alow priority. You must avoid giving a user process a high priority in hope that it will
execute faster because you could prevent essential system tasks from running. To change the process
priority, right-click the process and choose an option from the Set Priority menu of the context menu.

The second process property is affinity, which is the group of processors used to execute an
application. The default setting lets the process execute on all of the processors that a machine sup-
ports. In some cases, you might want to let one process use a particular processor, but not others,
to ensure the process doesn’t monopolize machine resources. To change the process affinity, right-
click the process and choose Set Affinity from the context menu. You'll see the Set Affinity dialog
box where you can clear or check processor entries. A process can only use the processors that you
have checked in the list.

The Processes tab shown in Figure 1.4 shows the default information that Microsoft feels most
administrators will need. However, you can change the amount of information that the Processes
tab displays by choosing View > Select Columns. You’ll see a Select Process Page Columns dialog
box where you can choose additional information to display on screen. Of course, these columns
tell you about the operational statistics of the process for the most part. The process also has file
characteristics that you may need to know, such as file version number. In this case, you right-click
the process entry and choose Properties from the context menu. The associated file Properties
dialog box appears behind Task Manager. Minimize Task Manager to review the file properties,
including the details such as file version shown on the Details tab of the Properties dialog box.

TIP Because of the way you work with Server Core, you may want to add the Process ldentifier
(PID) column to the display. The PID is important because every process has a unique PID. Con-
sequently, many command line utilities that work directly with processes require a PID as input
so that Windows knows which process to work with. Even if you start multiple copies of a particular
application, each copy has a unique PID, so knowing the PID helps you tell Windows precisely
which application copy to work with.

Working with Services

The Services tab of Task Manager shows all of the services currently installed on the machine, not
just those that the system is currently running. You can see the entire list of services, their Process
Identifier (PID), description, status, and group as shown in Figure 1.5.

You can also use the Task Manager to start and stop services as needed. Simply right-click the
service of interest and choose Start Service or Stop Service from the context menu as needed.

Services normally don’t run independently on Windows. A special application named Service Host
(SvcHost . EXE) provides a home for services. Consequently, when you see a SvcHost.EXE on the Pro-
cesses tab, you know that it has something to do with a service, but not which service. To see which ser-
vices the SvcHost . EXE entry affects, you can right-click the entry and choose Go To Service(s) from the
context menu. Task Manager opens the Services tab with all of the services hosted by that process high-
lighted. You can perform the opposite task as well. When you want to see the SvcHost . EXE entry that
hosts a service, right-click the service entry and choose Go To Process from the context menu.

Checking Performance

The Performance tab shown in Figure 1.6 doesn’t tell you a lot about the system, but it can provide
a quick overview of system health. For example, if all of the processors on a system are sitting at 100
percent all of the time, then you have a problem. Likewise, you can make a quick check of memory
to ensure the server isn’t running out.
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FIGURE 1.6
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The display doesn’t have many configuration options—you can’t change the display to show
you other statistics. The View » Update Speed menu has entries that let you change how fast the
display updates the statistics. You can also choose how to display the CPU information using the
View » CPU History menu. Finally, you can choose whether to display user times or kernel times
for the CPU history. When you check the View » Show Kernel Times option, the display shows
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how much CPU processing time the operating system is using. This statistic appears as a red line
on the display (in addition to the green line that shows overall CPU usage).

Observing Network Statistics

The default Networking tab shown in Figure 1.7 shows the total network usage for each Network
Interface Card (NIC) on the server. This graph gives you an idea of how well the network is per-
forming and lets you make changes to the system setup to improve network health.

FIGURE 1.7
. =2 Windows Task Manager = B
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As with the Performance tab, you don’'t have many configuration options for this display, but
you can change it in more ways than the Performance tab. The View » Update Speed menu has
entries that let you change how fast the display updates the statistics. The View » Network Adapter
History menu contains options that let you change the graphical display to show other network
statistics. You can see the bytes sent (red), bytes received (yellow), and total bytes (green) on the
display.

Notice that the bottom third of Figure 1.7 contains text information about the network. You can
change the amount of information that you see in this area by choosing View » Select Columns. The
resulting Select Networking Page Columns dialog box lets you choose the statistics you see in this

text data area. For example, you can choose to display the number of bytes sent or bytes received
in this area.

Managing Users

The Users tab tells you about the users currently logged into the system as shown in Figure 1.8. You
can determine the user’s ID, status, client machine name, and session information. This information
is important when using certain command line utilities because you need to identify a particular
user. In fact, a single user can log in more than once, but the machine information is different for
each login. All session numbers are unique, so you often need to know this information when
working with active user sessions. Unlike many of the other tabs described so far, the default setup
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for Task Manager shows all of the available user information columns and it’s usually not a good
idea to remove columns from the display.

F!GURE 1.8 i3 windows Task Manager [-[o]=] |
View and manage Flle Optons Wiew  Help
users on the tgplcations | Processes | Services | Performance | Netwarking |
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Disconned: ] Legaff Send|Messane..,
Processes: 31 jcPu Usage: 0% Physical Memary: 9% v

You can modify the state of a particular user as needed. To disconnect a current user session, you
can right-click the user entry and choose Disconnect from the context menu. Disconnecting a user
doesn’t end their session, but it does make server resources temporarily unavailable to them. If you
want to log off a user, right-click the user’s entry and choose Log Off from the context menu.

A List of Helpful GUI Utilities

Server Core comes with a number of helpful GUI utilities. These utilities don’t rely on the common
dialog boxes to perform tasks and they’re generally simple in nature. Even so, the utilities do pro-
vide useful functionality. The following sections describe a few of the utilities that you'll find in
Server Core. Other utilities appear throughout the book.

NOTE As previously mentioned, any utility that requires use of graphical features such as the
common dialog boxes or the managed .NET interface won’t work completely. They may appear to
work for a while, but you won’t be able to complete tasks with them. For example, you won’t be
able to display the Save As dialog box because it doesn’t exist in Server Core. Only utilities, such
as Notepad, that provide built-in dialog boxes will work.

Notepad

Most people are aware they can use Notepad to modify simple text files. For example, you could
use Notepad to write up basic notes for your server. However, you may not be aware that Notepad
can also help you perform basic administration chores. For example, many of the settings for
Windows now exist in XML files. You can use Notepad to modify these settings because XML files
are simple text.

Interestingly enough, the lack of common dialog box support in Server Core doesn’t affect any
of the Notepad features. You can open and save files as you normally do. All of the other Notepad
features work as expected. For example, you can perform a find and replace without any problem.
It's also possible to use Notepad to print files. Of course, you have all of the normal Notepad lim-
itations as well, such as an inability to work with graphics files.
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RegEdit

The RegEdit utility lets you make changes to the registry. In many cases, you'll need to make direct
registry changes in Server Core if you want to make local changes to configuration items. For example,
you can’t right-click the desktop and choose Properties to change the color of the screen. If you want
to change any of the display colors, you must perform the task in the registry using the RegEdit util-
ity. The older RegEdt32 utility now displays the RegEdit utility, so using either command displays
the same utility. Because the RegEdit utility has taken on so much new importance, you'll find it
discussed in detail in Chapter 4.

WinHelp

The WinHelp utility is still available to provide access to HLP files. Unfortunately, most applica-
tions don’t use HLP files any longer and rely on CHM files instead. To view a CHM file, you must
use the HTML Help (HH. EXE) utility, which doesn’t come with Server Core. When you need to view
CHM files, the best option is to open them on the client machine. You can do this at the command
line by typing HH MappedDrive:\FilePath\F1ileName and press Enter. The file opens as usual, but
you'll be looking at it from the host system. Copying the required help files to your local system is
also an option to improve help performance.

Accessing DLLs Using the RunDLL32 Utility

It's easy to think of a command as a built-in function within CMD. EXE and a utility as an external
application that you run. However, the command line presents a third alternative, one that you
might not have ever considered. The RunDLL32 . EXE file is a utility that you can’t run directly.
Instead, you feed it a DLL that contains one or more externally accessible functions and add any
arguments that the function requires as part of your input. For example, let’s say you want to add
abeep to your batch file. You can use the MessageBeep() function found in the User32.DLL file by
adding this command to a batch file or script.

RunDLL32 User32.DLL,MessageBeep

Notice that you type the utility name, RunDLL32, followed by the name of the DLL, User32.DLL,
and the name of the function, MessageBeep (). Note that the capitalization of the function you call
is important; MessageBeep isn't the same as messagebeep.

You have many resources for learning how to use this particular command line feature. The best
place to begin learning is the registry. Simply open the RegEdit utility and search for RunDLL32
entries by selecting the Edit » Find command and typing RunDLL32 in the Find What field.
Figure 1.9 shows a typical entry. In this case, the example shows how to install a new screen saver
using the RunDLL32 utility (a handy thing to know since there isn’t any way to do it from the user
interface).

Notice that, in this case, you pass the name of the screen saver file to the function. Replace any
variable entries, %1 in this case, with the actual filename you want to use when working at the com-
mand line. You'll find a wealth of RunDLL32 tips online, including suggested commands. Make
sure you always understand what a command will do and verify its functionality before you actu-
ally use it. Some wannabe comedians use their Web sites to get you to do odd and dangerous things
to your computer. One of the better Web sites to try is Using Rundll at http://www.ericphelps
.com/batch/rund11/.
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FIGURE 1.9
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The registry might not contain a solution for every need. You can look at the DLLs directly using
an application such as Depends (Dependency Walker). You can’t use the Dependency Walker at
the Server Core console, but you can use it at a client machine. This particular utility is used so often
by developers that it has its own Web site at http://www.dependencywalker.com/ with appro-
priate download links for various platforms. Figure 1.10 shows a typical view of a DLL opened in
the Depends utility. Most of the information displayed in this figure has nothing to do with the
command line and you can ignore it. However, the second window on the right side of the display

shows the list of functions in the DLL.
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Of course, Depends won't tell you what task the function performs or how to use it. To an extent,
you’'re left on your own as far as usage details and you’ll definitely want to spend time online look-
ing for suggestions. However, you can get complete details on the function when working with any
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Microsoft DLL on the MSDN Library Webssiteathttp://msdn.microsoft.com/1ibrary/.Simply
type the function name in the Search For field and click Search. Other vendors usually provide similar
documentation that you can use to learn more about the functions on their Web sites within DLLs.

WARNING Server Core (and most newer versions of Windows) places significant security
restrictions on users. Consequently, some RunDLL32 solutions that worked in the past might not
work today. Always test a RunDLL32 solution using the same privileges as the anticipated user,
rather than your own privileges, which are likely more inclusive.

Managing Windows in a New Way

Even though this chapter isn’t very long and it’s the first chapter in the book, you've already dis-
covered some essential facts about Windows Server 2008 Server Core. The most important fact is
that the command line actually provides faster access to many server resources as long as you know
the required command. In addition, the simple interface reduces your need to look for something—
you can concentrate on work. Of course, this chapter is only a peek into a much larger world for
administrators. This chapter helps you build these skills:

Define the Server Core difference in command line management

Describe how to access operating system configuration without the Control Panel
Configure your server for initial use

Perform tasks at the Logon screen

Manage applications and the environment using the Task Manager

® 6 & o o

Use a few GUI utilities to help manage the operating system
¢ Run DLLs using RunDLL32 to perform tasks at the command prompt

It's important that you get started working with the command prompt immediately. Otherwise,
you'll find that Windows Server 2008 Server Core can be an unfriendly place. Start by shutting
down your system. Type ShutDown —S and press Enter to shut down your system. After you restart
the system, type ShutDown -? and press Enter to display a list of other command line switches for
this command. Now try working with some of the other command line utilities described in this
chapter. Make sure you try using some of the RunDLL32 commands described in the chapter.

Chapter 2 provides the next step in discovering the command prompt. You'll discover how to
configure the command prompt and perform a number of new tasks with it. In addition, Chapter 2
helps you understand the difference between internal and external commands. Because the
“Understanding Internal and External Commands” section of the chapter is so important, you'll
want to read it even if you skip the rest of the chapter.
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